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Este  documento  ha  sido  escrito  como  un  tutorial  para  procesar  espectros  tomados  con  un
espectrógrafo Alpy 600 usando BASS. El mismo enfoque se puede utilizar para la mayoría de los
espectrógrafos de rendija.

Consulte el Manual del usuario de BASS para obtener información más detallada sobre cualquier
aspecto del procesamiento.

Los espectros utilizados en este tutorial se obtuvieron de François Cochard de Shelyak Instruments
durante el taller BAA Alpy en 2016.

Este tutorial especifica cómo acceder a las pantallas usando los menús. Muchas de las pantallas más
comunes y útiles también son accesibles desde los botones debajo de la barra de menú.
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1 - Apilar y calibrar imágenes:

El  primer  paso  es  apilar  las  imágenes  individuales  del  mismo  objetivo  y  aplicar  los  ajustes
necesarios de las imágenes para bias, campo oscuro y plano. Incluso si solo se cuenta con una
imagen de su objetivo, deberá seguir este proceso para realizar los ajustes de imagen. (Tenga en
cuenta que la calibración de longitud de onda se realiza más tarde).

Por supuesto, se puede realizar el apilamiento y la calibración en su software de procesamiento
de imágenes preferido. En cuyo caso salte a la sección 2 o 3 según corresponda.

Menú: Archivo -> Apilar imágenes

Primero seleccione sus "Imágenes espectrales del objetivo o de los objetivos en caso de estudios
comparativos". Estas son las imágenes de su espectro estelar objetivo.

Asegúrese  de  que  esté  seleccionado  "sin  alineación".  Cualquier  alineación  invalidaría  las
correcciones geométricas que se aplicarían posteriormente.
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A continuación, seleccione sus imágenes oscuras, sesgadas y planas. Si el tiempo de exposición de
sus imágenes oscuras es el mismo que el de sus imágenes claras, entonces no se necesita imágenes
del ruido o interferencias que produce la cámara. Sin embargo, la inclusión de fotogramas de bias
(ruido) permite a BASS escalar 1 conjunto de fotogramas oscuros para que coincida con cualquier
tiempo de exposición a la luz.

Las sombras planas pueden mejorar la calidad de su campo plano, pero deben coincidir con el
tiempo de exposición de sus imágenes planas.

Si  tiene  un  archivo  cosmético  maestro  que  enumera  los  píxeles  calientes  en  su  cámara,  debe
seleccionarlo en el cuadro Archivo cosmético. La creación de un archivo cosmético se explica en la
siguiente sección.

Ahora  se  presiona  “Stack”  (apilar)  y  las  tomas  quedarán  apiladas  en  una  nueva  imagen  más
sensible.
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 Cambiamos el título de la imagen apilada, en este caso Vega. Para hacer esto, simplemente haga
doble clic en la imagen y luego cambie el cuadro Título. Esto actualizará la leyenda en la gráfica.

Finalmente guarde su imagen con un nombre apropiado.

Menú: Archivo -> Guardar imagen como…

Es importante, para la organización de nuestros espectros, incluir el objeto, la fecha y, a veces, la
hora, y una descripción del paso de procesamiento, p. Vega_20150820_Stack.fit.
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2 - Eliminación de píxeles calientes y rayos cósmicos

Este paso suele ser necesario para limpiar la imagen. Sin este paso, es posible que tenga picos en su
espectro final debido a píxeles calientes o impactos de rayos cósmicos.

Hay 2 enfoques que se pueden utilizar:

• Cree un mapa maestro de píxeles calientes a partir de su imagen maestra oscura. Esto brinda una
eliminación confiable de píxeles calientes, pero no eliminará los impactos de rayos cósmicos de su
imagen  de  espectro  apilado.
• Detectarlos y eliminarlos de su imagen apilada. Este enfoque es más difícil ya que debe evitar
eliminar el espectro que puede parecerse un poco a los píxeles calientes. Este paso es necesario si
tiene impactos de rayos cósmicos.

El mejor enfoque es una combinación de los dos métodos. Primero, aplique un mapa maestro de
píxeles  calientes  creado  con  su  imagen  maestra  oscura.  Si  tiene  impactos  de  rayos  cósmicos,
continúe con una corrección en su imagen apilada para eliminar los rayos cósmicos.

Para acceder a la pantalla:

Menú: Imagen -> Eliminación de píxeles cósmicos, calientes y fríos sin calor

                   No se detectaron píxeles calientes ni rayos cósmicos en esta imagen en el umbral del 74 %.
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a. Creación de un mapa de píxeles activos

Una forma excelente de detectar píxeles calientes es utilizar una imagen maestra oscura. BASS
habrá creado automáticamente dicha imagen siempre que haya dejado marcada la opción "Guardar
imágenes maestras" en la pantalla "Apilar imágenes". Además, normalmente puede usar el mismo
mapa durante varios meses.

Para ayudar a ver los píxeles calientes podemos modificar los niveles de blanco y negro haciendo
clic en el botón

Luego ajustamos el nivel de blanco y negro a valores bajos. Aquí 0 y 2500. Un nivel de blanco de
2500 significa que cualquier píxel  de 2500 ADU (Medida de Intensidad de la  Luz Captada)  y
superior será blanco, y entre 0 y 2500 se escalará de negro a blanco.

Ahora  se  puede comenzar  con la  eliminación de  píxeles  calientes.  Ajustamos  el  porcentaje  de
umbral hasta que capte la mayoría de los píxeles activos. Los píxeles calientes se indicarán con
pequeñas cruces verdes. El valor de umbral de ADU se mostrará cuando mueva el mouse sobre el
control deslizante.

En este ejemplo se ha fijado un umbral de 0,45 % (408 ADU), ya que se muestran los píxeles
calientes sin saturar la imagen. Si se tratara de una imagen de espectro, se necesitaría un porcentaje
más alto para evitar eliminar las partes más brillantes del espectro.
Utilice las barras laterales para moverse por la imagen y comprobar que ha recogido la mayoría de
los píxeles calientes sin tocar la mayoría de los píxeles.
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Haga clic en la pestaña "Archivo cosmético" y presione Guardar para crear un archivo maestro que
enumere los píxeles calientes. Un buen nombre de archivo sería "cosmetic.lst".

Este mapa de píxeles calientes se puede aplicar a su imagen apilada presionando el botón Aplicar.
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Podemos  usarlo  también  en   futuros  procesamientos  seleccionando  "Archivo  cosmético"  en  la
pestaña "Otras imágenes" de la pantalla "Imágenes apiladas".
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b. Eliminación de píxeles cósmicos y calientes de un espectro

Hay que tener en cuenta en cuenta que un mapa de píxeles calientes no eliminaría los impactos de
rayos cósmicos  como suceden en  imágenes  individuales.  Si  tiene  impactos  de  rayos cósmicos,
debemos eliminarlos ejecutando la Eliminación de píxeles cósmicos, calientes y fríos.

Como antes, ajuste los niveles de blanco y negro con el botón      para que el espectro y los rayos
cósmicos y los píxeles calientes se vean bien y claros.

Ajustamos  el  control  deslizante  de  umbral  hasta  que  elimine los  rayos cósmicos  o  los  píxeles
calientes, pero sin eliminar nada del espectro. Esto puede ser complicado, así que asegúrese de
tomarse su tiempo. Es muy importante no eliminar ninguna parte brillante de la imagen del espectro
al eliminar los píxeles calientes y los rayos cósmicos.

No se observan impactos claros de rayos cósmicos en las imágenes de muestra de este tutorial. En
cambio, arriba se muestra un espectro de alta resolución tomado con un Lhires III con muchos
píxeles calientes.
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3 - Correcciones Geométricas

Las correcciones geométricas deben aplicarse tanto a sus imágenes estelares (apiladas) como a las
imágenes  de  calibración  de  líneas  de  neón u  otras  líneas  de  emisión  al  mismo tiempo.  De lo
contrario, la geometría de la imagen de calibración de longitud de onda y las imágenes de estrellas
no estarán sincronizadas. Esto hará que la calibración de la longitud de onda varíe con la posición
vertical en la imagen y, por lo tanto, sea incorrecta.

Si está usando un espectrógrafo de hendidura pero no está usando una lámpara de calibración de
longitud de onda, entonces puede usar un alumbrado público o un espectro similar con líneas de
emisión para realizar la corrección de sonrisa/inclinación.

Se debe tener todas las diferentes imágenes del espectro estelar apiladas y su imagen de calibración
de longitud de onda (por ejemplo, espectro de línea de neón) abiertas en BASS.

La Vista de tira de imagen debe establecerse en "Imagen sin procesar..." en un porcentaje que le
permita ver un buen nivel de detalle.

Es recomendable aplicar las correcciones geométricas en el siguiente orden:

1 Corrección de rotación/inclinación
2 Corrección de curva / Corrección de inclinación

Esto se debe a que el  ajuste de rotación/inclinación cambiará el  ángulo de inclinación, pero la
inclinación no cambiará la inclinación.

MENU »»»» Image »»»» Rotate/ Tilt correction

MENU »»»» Image »»»» Smile/ Slant correction
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a. Corrección de rotación/inclinación

Seleccionamos uno de los espectros cargados, el borde de la imagen se vuelve amarillo. Se debe
configurar los niveles de blanco y negro de manera que la imagen del espectro sea clara.

Menú: Image -> Niveles de blanco y negro (Black & White Levels)

No se preocupe si tiene algunos valores de píxeles negativos. Esto es causado por el ruido aleatorio
en la corriente oscura y la polarización.

Para hacer su espectro perfectamente horizontal usamos la siguiente pantalla de menú.

Menú: Imagen -> Rotar / Corrección de inclinación (Rotate/ Tilt correction)

Cuando  trabajamos  con  varias  imágenes  debemos  seleccionar  la  opción  Apply  levels  all  open
images (Aplicar los niveles a todas las imágenes).
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Seleccionamos un rectángulo alrededor de nuestro espèctro:

Hacemos clic en Aplicar.

Debemos  verificar  que  el  espectro  queda verdaderamente  en  horizontal.  Para  ello,  volvemos  a
dibujar   un   rectángulo   ajustado  sobre  el espectro.   Para   corregir   el   ángulo   de    inclinación
       seleccionamos una magnitud, positiva o negativa según el caso, y de una cantidad o mayor o
menor cada vez hasta conseguir el encaje rectangular perfecto.
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b. Corrección de sonrisa / inclinación

Situamos la imagen de neón la primera haciendo clic derecho en la imagen, Secuencia, luego 01.

Menú: Imagen -> Sonrisa / Corrección de inclinación (Smile/ Slant correction)

Activamos la opción "Aplicar a todas las imágenes abiertas".

Seleccionamos un rectángulo vertical sobre una de las lineas de calibración, no demasiado cerca de
los  bordes,  manteniendo  la  altura  de  selección  dentro  de  la  línea  de  emisión  (o  los  extremos
añadirán ruido a los cálculos).
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Seleccionamos la Regresión en Lineal y Probamos (Try).

Si la línea roja se superpone a la línea de emisión el ajuste es correcto. De lo contrario, como en el
ejemplo de las figuras, debemos ajustar los parámetros Promedio de píxeles (Pixeles Average) y
Regresión y probar de nuevo.

Cuando el ajuste es correcto (ver figura) seleccionamos         aplicar a todas las imágenes y hacemos
clic en “Apply”.

15



Las líneas de emisión han sido corregidas en su curvatura vertical. También el resto de imágenes
espectrales habrán sido corregidas.

Ahora  debemos  guardar  las  imágenes  corregidas  diferenciándolas  de  las  originales  para  poder
conservar éstas últimas. Podemos agregar “_geo” al final de sus nombres originales, por ejemplo.
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4 - Seleccionar “regiones activas”*

Seleccionamos la imagen del espectro,

Ajustamos el nivel de zoom     para tener una vista del espectro completo. 

Ajustamos los  niveles  de blanco y negro para  que la  imagen del  espectro aparezca  brillante  y
puedan verse fácilmente las partes más débiles de la imagen del espectro. No importa en este paso
que el espectro parezca superexpuesto.

Menú: Imagen -> Niveles de blanco y negro 

* En el menú Selección encontraremos las opciones para seleccionar las distintas regiones con las
que el programa operará.
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Seleccionamos un rectángulo alrededor de la parte más ancha del espectro ajustándolo bastante. Lo
que importa es que las partes superior e inferior del espectro estén completamente encerradas y que
se incluya la menor cantidad de fondo posible. 

Ahora vamos al menu Selección y seleccionamos Región activa del espectro (“Set Active Bining
Region”)

Menu: Selection -> Set Active Binning Region

Dos lineas verdes aparecerán delimitando la región de la imagen superior e inferiormente. Esta
región será la usada para procesar la imagen y obtener un espectro limpio.
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Ahora  seleccionamos  una  región rectangular  por  encima de  su  espectro.  Esta  región,  separada
claramente de la región del espectro, capta la emisión del cielo sobre nuestra imagen.

Menu: Selection -> Set Active Subtraction Region 1

Dos lineas rosas delimitarán la primera región que el programa usará para restar a la imagen el
fondo del cielo.
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Ahora debemos repetir la operación seleccionando otra región por debajo de la región del espectro.

Menu: Selection -> Set Active Subtraction Region 2

Observamos como otras dos lineas rosas delimitan la segunda región de fondo del cielo.
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Ahora podemos volver a la vista de zoom original y corregir los niveles de blanco y negro.
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Es aconsejable que la región activa del espectro coincida con la región activa de la imagen de
calibración.

Para  ello,  seleccionamos  la  imagen  de  calibración  de  neón  para  que  se  resalte  con  un  borde
amarillo, hacemos clic con el  botón derecho en la imagen y seleccionamos copiar la región de
agrupación activa desde la imagen del espectro de estrellas en la que configuró la región de activa
de procesamiento.

Así,  la  delimitación  de  la  región  activa  será  la  misma  en  ambas  imágenes,  como  podemos
comprobar en las nuevas lineas verdes de la imagen de calibración.
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5 - Calibración de longitud de onda

La calibración del espectro puede parecer más difícil de lo que realmente resulta en la práctica. 

Lo  ideal  es  tener  un  espectro  de  referencia  ó  calibración  para  cada  sesión  fotográfica.  La
temperatura, situación del equipo y otros factores pueden influir de una sesión a otra. Es preferible
tener espectros de elementos puros y no mezclados: Neon y Argón son los más populares.

La primera subsección a continuación proporciona algunos espectros de baja resolución de muestra.
Estos nos ayudarán a identificar las líneas para la calibración de la longitud de onda.

La siguiente subsección explica cómo realizar la calibración de la longitud de onda del espectro
estelar utilizando un espectro de lámpara de calibración de línea de emisión de neón o similar.

Si no se posee una lámpara de calibración, la última subsección explica cómo realizar la calibración
de longitud de onda utilizando una estrella de tipo A o B.

a. Muestra de espectros de calibración

A continuación se muestran algunos espectros de muestra de varios sitios web que pueden ayudar a
identificar las líneas en su espectro de calibración.

Espectro de neón del sitio web de Christian Buil: http://www.astrosurf.com/buil/us/spe2/hresol4.htm
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De la Guía de Usuario del Espectrógrafo Alpy

Imagen del sitio web de Christian Buil’s;

http://www.astrosurf.com/buil/alpy600/first_light.htm 
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Encontramos las siguientes lineas de calibració n en el espectro de calibració n del espectró grafo Alpy.

• • 4200.67 Ar 

• • 4764.87 Ar 

• • 5852.49 Ne 

• • 6562.85 Hα 

• • 6965.43 Ar 

• • 7272.94 Ar 

A continuación vemos los espectros de emisión de algunos elementos (recortándolos como imagen
pueden servir para nuestras pruebas con BASS, IRIS u otro programa espectral.
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b. Proceso de calibración de longitud de onda

Seleccionar  la  imagen  del  espectro  referencia  para  la  calibración  (neón,  argón)  que  estemos
utilizando. Esta imagen debe estar en la posición 1, debe ser la primera por arriba. Si no fuera así,
hacemos clic derecho en la imagen, seleccionamos Secuencia y luego 01.

Desplazamos la pantalla hacia abajo hasta el área del gráfico de los espectros. La calibración se
realiza sobre el gráfico resultante de los espectros abiertos. 

Para pasar al modo de calibración, seleccionamos:  Menú.- Calibración -> Crear/Editar Calibración
ó a través del icono 

Una linea roja aparece con un semicírculo en la base. Esta linea se desplaza con el ratón y nos
servirá para determinar las lineas de calibración
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Situamos la linea roja sobre una de las líneas de neón de las que debemos conocer su longitud de
honda, aunque el programa tiene recursos para indicarlas. Apretando shift hacemos doble clic sobre
la linea y automáticamente aparecerá el menú Calibración de los Puntos de Referencia

Podemos introducir la longitud de honda manualmente sirviéndonos de alguna tabla o listado externo.
BASS tiene una base de datos interna que ayuda en nuestro trabajo. Seleccionamos en “Element filter”
Ne  (en  nuestro  ejemplo)  y  después  en  “Enter  or  select  wavelength  (A)”  la  longitud  de  onda
correspondiente  a  la  linea  seleccionada.  Repetiremos  con  otras  lineas  hasta  que  el  error  sea
aceptable(+- 0.2)
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En el ejemplo que seguimos, hemos seleccionado 3 lineas y obtenido un error lineal máximo de 0.2,
aunque para ciertos estudios puede seraceptable, para trabajar con más precisión no. Cuantas más
lineas de calibración se introduzcan, mayor será el error lineal. Nosotros con la calibración con tres
lineas de referencia, seleccionamos la forma de calibración “Quadratic” en “Calibration fit”, de
forma que obtenemos un error de “0” para todas las lineas.

Es de suma importancia para trabajos de investigación que el espectro de luz de referencia para
calibración, en nuestro caso el de neón, sea adquirido en las condiciones mas similares posibles,
sino idénticas. Así evitaremos errores debidos a las condiciones de captura de los espectros.
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En ocasiones, puede ser posible mejorar el ajuste eligiendo más líneas, o aumentando el polinomio
del ajuste de calibración (Fit calibration). Sin embargo, hay que tener cuidado. Elegir un polinomio
de alto orden de 1 por debajo de su número de puntos de calibración o superior siempre dará un
ajuste perfecto. Esto es engañoso ya que simplemente está ajustando la cantidad de parámetros
libres en el polinomio a su cantidad de puntos de datos. Incluso si elige una línea completamente
incorrecta, el ajuste seguirá siendo perfecto. Así pues, debemos calibrar con el menor error lineal
posible y el polinomio de cálculo (Fit Calibration) mas bajo posible.

A continuación, podemos configurar la vista de la imagen como una banda en Color  para mostrar
los espectros en color (Image Strep View).
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Para copiar los parámetros de calibración en el espectro objetivo, haga doble clic en la imagen de la
estrella objetivo.

Seleccione la pestaña Calibración.

Luego presione Copiar.

Y guardamos las imágenes espectrales.
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C. Calibración de longitud de onda con una estrella tipo A o B

Si no disponemos de una lámpara de calibración para calibrar la longitud de onda del espectro, es
posible usar las líneas de hidrógeno de una estrella de tipo A o B.

Para hacer esto, se toma una imagen del espectro de una estrella de tipo A o B, con el equipo
exactamente en la misma configuración y condiciones que cuando tomó todos los espectros de sus
estrellas objetivo, preferiblemente justo antes o después de las tomas. Debemos elegir una estrella
brillante de tipo A o B con líneas claras de absorción de hidrógeno. Vega es ideal cuando es visible.
Necesitamos ver fácilmente las líneas de absorción desde H-alfa hasta al menos H-delta o más.

El proceso básico es el mismo que si estuviera usando una lámpara de calibración.

La imagen de estrella de tipo A o B debe ser la primera imagen en BASS.

Haga clic con el botón derecho en la imagen -> Secuencia

Seleccionamos la imagen de la estrella tipo A o B que hemos tomado como referencia espectral.

Realizamos las selecciones de área como vimos anteriormente, tanto de la imagen de la estrella de
referencia cono del espectro objetivo.

Pasamos al  área del  gráfico de la  pantalla,  ya que todas las  operaciones  se realizarán sobre el
gráfico.

Operamos igual que con un espectro de calibración visto anteriormente.
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Para pasar al modo de calibración, seleccionamos el siguiente elemento del menú.

Menú: Calibración -> Crear/Editar Calibración

Es más fácil comenzar seleccionando H-alfa, la línea de hidrógeno más a la derecha. Esto se hace
colocando el cursor justo a la izquierda de la línea en el gráfico, arrastrándolo hacia la derecha de la
línea y luego soltándolo.

Seleccionamos el Hidrógeno en el filtro Elemento y Hα en el menú desplegable de longitud de
onda.
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Hacemos clic en Agregar otro punto y repetimos la operación hasta que se vean todas las líneas
principales del hidrógeno.

Al principio, con un ajuste lineal, los errores pueden ser grandes.

Cambiar la forma de calibración a Cuadrático o Cúbico dará un mejor resultado.
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Ahora tenemos un espectro bien calibrado, aunque se debe tener cuidado con las longitudes de onda
por debajo del punto de calibración más corto y por encima del punto de calibración de longitud de
onda más larga.

Podemos obtener una vista de color de sus tiras de imagen de espectro cambiando la Vista de tira de
imagen a Color de sintetizador (estiramiento).
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Para copiar la calibración a otra estrella, haga doble clic en la franja de imágenes de esa estrella.
Seleccione la pestaña Calibración.

Hacemos clic en “Copy” para copiar la calibración a nuestro espectro objetivo.
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6 - Corrección de respuesta (avanzado).

Normalmente se utiliza una estrella de tipo A o B para obtener la corrección de la respuesta. Los
espectros de este tipo de estrellas son muy simples dominados por la absorción de las líneas de
Balmer del hidrógeno. Esta curva de corrección de respuesta se puede aplicar a otras estrellas a una
altitud similar en la misma noche.

Lo que buscamos es una curva que corregirá los efectos de la instrumentación y la atmósfera de la
Tierra. Al aplicar esta curva, el espectro debe corregirse y mostrar el espectro estelar real que hemos
captado de esa estrella en esa sesión. Debemos tener en cuenta que nuestro espectro final diferirá
del tipo espectral perfecto.

Debemos evitar corregir la respuesta de cada espectro de estrella objetivo por separado utilizando
un espectro de plantilla que coincida con su tipo espectral. De otra forma, siempre obtendríamos un
ajuste perfecto coincidente con el tipo espectral, ya que forzaríamos el procesamiento del espectro
para que coincida con la  plantilla con la que se comenzó. También, si el espectro de la estrella no
coincide perfectamente con su tipo espectral, algo que ocurre con frecuencia, el espectro corregido
harí que parezca que coincide perfectamente.

El siguiente proceso utiliza la estrella A0V Vega para crear una curva de respuesta y luego confirma
que funcionó comparándola con una plantilla A0V. En el trabajo científico este sería el primer paso.
A continuación, esta curva de respuesta se aplicaría a sus estrellas objetivo que no sean Vega.

Este tipo de corrección se realiza sobre espectros tomados en la misma sesión y con la misma
configuración  de  dispositivos.  No  podemos  aplicar  una  curva  de  respuesta  realizada  sobre  un
espectro de 200 l/mm en otro de 600l/mm, o tomados con diferentes cámaras.
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Primero cargamos un espectro estándar apropiado para que coincida con el que está trabajando. Lo
ideal sería un espectro de Miles1 de la estrella exacta pero, también nos vale un espectro de Pickles
para el tipo espectral.

Debemos tener en cuenta que si usamos una estrella Miles, no debe usar los espectros etiquetados
como  "dered";  Estos  son  espectros  que  han  sido  corregidos  por  extinción  interestelar  y  que
invalidarían su curva de respuesta.

Menú: Herramientas -> Espectro de referencia        Menu: Tools -> Reference Spectrum

Si usa una estrella de la base de datos de Miles, hacemos clic en “Source” y seleccionamos Miles.
Luego busque el número HD de la estrella.

En este ejemplo usamos Vega, que no está en la base de datos de Miles. Entonces seleccionaremos
el espectro Pickles A0V.

Seleccionamos “Add Spectrum to Chart” y cerramos. 

Así, hemos agregado el espectro de referencia A0V como un tercer perfil.

1 La base de datos Miles puede ser descargada de https://groups.io/g/BassSpectro/files/Miles%20Reference
%20Spectra/MilesLibraryBASS.zip y copiarla en la carpeta correnpondiente dentro del directorio de BASS.
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El siguiente paso es dividir su espectro por el espectro estándar.

Menú: Operación -> Dividir un perfil por otro

Nuestro espectro es el primer perfil y el espectro estándar es el segundo perfil.

Ahora tenemos que suavizar los baches y picos. Solo las características a gran escala forman parte
del perfil de respuesta. Las características de menor escala se deben a diferentes resoluciones y
otros efectos de pequeña escala que no se pueden corregir.

Para facilitar este proceso, primero eliminaremos y ocultaremos los otros espectros.

Eliminamos  el  espectro  de  neón  seleccionándolo,  luego  clic  derecho  y  presionamos  Eliminar
imagen (Remove image).

Eliminamos el espectro Pickles A0V seleccionándolo, luego clic derecho y presionamos Eliminar
imagen (Remove image).

Ocultamos nuestra imagen/espectro seleccionándolo, luego clic con el botón derecho y presionamos
Ocultar perfil del gráfico (Hide Profile from Chart).
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Ahora tenemos sólo el perfil de división de la siguiente manera.

Debemos asegurarnos de que el perfil de división esté seleccionado.

Ahora estamos listos para crear la curva de respuesta suave.

Menú: Herramientas -> Modulador Continuo                       Menu: Tools -> Continuum Shaper

Seleccionamos el perfil de división como el perfil de destino.
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Entonces iremos haciendo doble clic en los puntos más relevantes a lo largo del perfil de izquierda a
derecha, omitiendo valles y picos, tal y como muestra la imagen.

Podemos corregir cualquier error haciendo doble clic en un punto por segunda vez para eliminarlo.

Ahora guardamos. Aquí hay varias opciones, sugerimos guardar como un archivo DAT de respuesta
en la carpeta donde está trabajando, y nombrándolo con referencia a nuestro trabajo en curso. En
este  caso   “vega_response.dat”.  Entonces  estará  disponible  para  ser  utilizado  para  todos  sus
espectros de esa noche/sesión.
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Ahora  doble  clic  en  nuestro  perfil  y  seleccionamos  la  pestaña  Respuesta.  A  continuación,
seleccionamos el archivo que acaba de crear en el cuadro Archivo de respuesta.

Aquí está nuestro espectro corregido por nuestra curva de respuesta.

Puedemos compararlo con el Pickles A0V para comprobar lo bien que ha funcionado. Esto nos
ayudará a refinar nuestra técnica.
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7 – Recortar el Espectro

Por defecto, el espectro incluye regiones que no son precisas debido a las limitaciones de nuestro
equipo (telescopio, espectrógrafo, cámara, ...) y a la atmósfera. Es una buena práctica recortar el
espectro a la región de longitud de onda que deseamos analizar.

Menú: Gráfico -> Recortar rango del eje X             Menu: Chart -> Crop X-Axis range

Rellenamos manualmente el rango de recorte.
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8 - Guardando el Espectro

Es una práctica estandarizada guardar el espectro terminado como un archivo de ajuste 1D o un
archivo dat 1D. El espectro se compone simplemente de valores de longitud de onda e intensidad,
por lo que no necesita la imagen 2D de su espectro una vez que lo haya procesado. Esto permitirá
compartir el espectro y abrirlo en otros paquetes de espectroscopia.

Menú: Archivo -> Guardar como perfil 1D
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9 - Configuración de BeSS / BAA

Los archivos de espectro de buena calidad se pueden enviar a bases de datos como BAA, BeSS y
ARAS. Todos estos necesitan espectros para guardarse como archivos del mismo formato. Este
formato es archivos de ajuste 1D que cumplen con el estándar BeSS, lo que básicamente significa
que se completan ciertos campos de encabezado de ajuste. BASS tiene un menú para completar
estos campos para que sea sencillo crear archivos compatibles.

a. Elaborando la resolución

Antes de continuar, necesitamos saber la resolución del espectro. La forma más fácil de calcular
esto es abrir el espectro de neón calibrado en su longitud de onda. Para medir la resolución, haga
clic en el siguiente elemento del menú:

Menú: Herramientas -> Medidas y Elementos

En Opciones de medición, marque FWHM. Esto significa ancho completo a la mitad del máximo,
una medida del ancho de una línea espectral.

Seleccionamos una línea clara y brillante cerca de la mitad del espectro de neón. Presionamos y
arrastramos el cursor de izquierda a derecha a lo largo de la línea espectral.
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Luego observamos la ventana de resultados de la medición.

El FWHM da los números que precisábamos, son el valor R y la longitud de onda, entonces 554 y
5852.2.
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b. Rellenar la configuración de BeSS

Seleccionamos el archivo de espectro 1D  y luego usamos el menú.

Menú: Imagen -> Configuración de BeSS

La primera pestaña se puede completar de la siguiente manera con los datos:
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La siguiente pestaña solo necesita el nombre del objeto. Otros detalles pueden ser útiles pero no son
necesarios para las bases de datos BeSS, BAA o ARAS.
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La tercera pestaña necesita los detalles de la adquisición.

Usamos el botón "Leer del perfil" para completar los datos de calibración.

Luego introducimos el "SRP efectivo" y la "Longitud de onda de cálculo de resolución" del cálculo
de resolución anterior.
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La cuarta pestaña llamada "Procesamiento" normalmente se puede completar de la siguiente forma.

No se debe aplicar ninguna corrección heliocéntrica al enviar a las bases de datos a menos que se
haya solicitado específicamente.

Presionamos el botón “Validar BeSS”.

Suponiendo que no haya problemas indicados por la validación, presionamos "Guardar encabezado
FIT". El encabezado Guardar FITS actualiza el archivo de ajustes 1D, por lo que no es necesario
volver a guardar el archivo.

Ahora se puede cerrar la ventana de configuración de BeSS.

A continuación,  podemos  enviar  este  archivo  a  una  base  de  datos  como  la  base  de  datos  de
espectroscopia de BAA, BeSS y ARAS. Tenga en cuenta que no todas las bases de datos están
interesadas en todos los objetos, por ejemplo, BeSS es solo para las estrellas Be y Herbig Ae/Be.
También debemos asegurarnos de que el espectro procesado sea de buena calidad.
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10 - Creación de archivos .bass y .bun de su sesión

BASS tiene una función muy útil que le permite crear un archivo de proyecto o un paquete que
contiene  todas  sus  imágenes,  espectros  y  configuraciones.  Los  archivos  de  paquete  son
especialmente  útiles  si  algo  va  mal  con el  proceso  de  reducción,  ya  que  se  pueden usar  para
compartir la sesión BASS con otros usuarios para que puedan brindarle ayuda.

Para guardar la sesión BASS:                                    Menú: Archivo -> Guardar proyecto

Esta pantalla tiene la opción de guardar como 2 tipos de archivos:

• .bass

• .bun

.bass
Guarda un archivo de proyecto para su sesión que contiene su configuración y enlaces a las

imágenes y perfiles de espectro almacenados en su computadora. Entonces, cuando vuelva a abrir
un archivo .bass, volverá a abrir todas las imágenes y espectros desde su ubicación original en su
computadora. Esto es bueno para uso personal ya que no duplica los archivos, y cualquier cambio
que realice actualizará esos mismos archivos.

.bun
Crea un archivo de paquete que contiene todas sus imágenes y perfiles de espectro en el

archivo  .bun,  así  como  todas  sus  configuraciones.  Cuando  abra  un  archivo  .bun,  extraerá  las
imágenes y los perfiles de espectro en una nueva carpeta de su elección. Es una buena idea guardar
un archivo .bass antes de crear un archivo .bun.
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Para abrir un proyecto:

Menu: Archivo → Abrir Proyecto           Menu: File -> Open Project

El menú desplegable en la parte inferior izquierda permite elegir entre un proyecto (.bass) o un
archivo de paquete (.bun).

Si seleccionamos un archivo de paquete, el programa preguntará dónde deseamos desempaquetar el
paquete. Esto creará copias de todas sus imágenes, espectros y configuraciones en esa carpeta. De
forma predeterminada, la carpeta será el nombre del archivo Bun, pero podemos elegir una carpeta
diferente con el botón de exploración.
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Una vez  desempaquetado,  BASS abrirá  todas  las  imágenes  y  perfiles  de  espectro  de  la  nueva
carpeta. Por lo tanto, esto no se vinculará con las copias originales de las imágenes y espectros.
A continuación se muestra un ejemplo de un paquete desempaquetado.
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